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Welcome To Power Print

Power to your Printer!

Power Print delivers a new dimension of power to your dot
matrix printer. It enables you to switch between the serviceable
but ordinary font that came with your printer

STAMDARD: ABCDEabcde 12345

and an unlimited variety of custom fonts that add clarity and
impact to your printed output.

COUNT: ABCDabcdETEIRET
BYTE: RBLCDEl12345e49300

OUTLENS : X¥2 oXLD ENGLISH

Before we go any further, let's define font. A font is simply a
set of characters -- letters, numbers, special characters, and
symbols -- that have the same style.

You may use one of the custom fonts that are supplied on the
Power Print disk, or you may design your own fonts.

Power Print Works With AppleWorks

Power Print is compatible with AppleWorks. In fact, it can be
used with virtually any program that you run on your Apple //e,
//c, /[+ (or //-anything) computer.
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Power Print works on a wide variety of dot matrix printers with
"downloading" capability. Downloading means that
information can be transferred "down" from the computer to an
area in the printer's memory called the download buffer.



Three Ways To Use Power
Print

Power Print offers three powerful, easy-to-use options:

+ Use the ready-made custom fonts
provided on the Power Print disk.
These ready-made fonts allow you to
create a variety of effects to enhance
your printed documents. You can even
draw borders.

+ Modify the ready-made fonts to suit your
exact needs.

» Create your own fonts "from scratch.”
The possibilities are as limitless as your
imagination and ingenuity. You can
store your own fonts on disk for repeat
use. ‘

No matter which option you choose, Power Print is easy to
use. Here are the basic steps:

One time only: Identify the kind of printer and interface you
use. This Printer Setup has to be done only once; there's no
need to re-do it unless you change to a different nrinter or
interface.



1 Sclect a ready-made font, or modify a
ready-made font, or create your own
font.

2 Download the font (ready-made,
modified, or scratch) to the printer.

3 Exit Power Print and load the program

you want to use. When you print a
document, the printer will use the font

that was downloaded from Power Print.
This font will be used until you turn off
the printer or until you use Power Print
to download a different font.

These steps are explained on the following pages.

About This Manual

This manual leads you through some simple examples of how
to set up and use Power Print. Just fire up your Apple, load
the program, and follow along.

We know -- it takes time to read all the explanatory stuff
between the fun parts where you get to push buttons and watch
what happens. Trust us: time spent now reading the material
and proceeding cautiously will save you time and aggravation
in the future. The first time through may go slowly, but Power
Print is easy to use and soon you will be an expert.

The first part of this manual teaches you about the basics of
Power Print: how to set up your printer and how to select and
use ready-made fonts. Then we tell you how to use Power
Print with AppleWorks. Finally, we describe how to modify
ready-made fonts and create fonts from scratch, and we tell you
about some special tricks you can try.



Help!

If at some point you feel the need to shout "help!"” go right
ahead and do so. A more productive option is simply to type a
question mark (?). A help screen will appear that gives
information about the part of Power Print you're currently
using.

Also, the Notes option in the Apple Menu contains up-to-the-
minute information about Power Print. Be sure to read the
Notes before you start to use the program (the next section
describes how to start the program and select a menu option).

Don't Leave Home Without Backing Up

Before you get into Power Print, remember to make a working
copy of the Power Print disk. Use the copy and store the
original in a safe place. As with all Beagle software, there is no
copy protection so backup is quick and easy. Please respect the
copyright laws that pertain to computer software. You support
us and we'll support you.



The First Step:
Printer Setup

Power Print works with a wide variety of dot matrix printers
that have full font downloading capability (check your owner's
manual). To do its job, Power Print needs to know which
printer you are using, as well as which printer interface and
interface slot number. We call this information the Printer
Setup. The Printer Setup is stored on the Power Print disk, so
each time you load Power Print it automatically knows which
printer you're using.

You do the Printer Setup only once; you do not have to repeat it
unless you switch to a different printer. If you regularly use
more than one kind of printer, we suggest you make a separate
Power Print disk for each printer.

Yes, that time has finally come: race to your Apple, insert the
Power Print disk in drive 1, and turn on the computer. (Apple
//lc and //e users: If your computer is already on, press
control, open-apple, and reset at the same time, then
release reset first.)

Now press any key; the Power Print main program screen will
appear (Figure 1).



288

& File Edit Printer

KEY:! ASCII: 33
i MATRIX: 8x9

Figure 1: Main Program Screen

We want to view the Apple Menu (designated by the Apple
symbol) at the upper left of the screen. Press the esc key and
the Apple Menu options will appear as shown in Figure 2.

File Edit Printer
About Power Print...
Printer Setup
Help
Hotes

Figure 2: Apple Menu

To select one of the options in a menu, use the up arrow and
down arrow keys (on the Apple //+, use A for up and Z for
down) to move up and down within the menu. Each selection
is highlighted as you come to it. The left arrow and right
arrow keys move you between the various menus: Apple,
File, Edit, and Printer.



Sometimes an option within a menu will appear to be faded or
dimmed. This means the option is disabled and you can't use
it. For example, some printers (such as the Epson FX-80/FX-
100) allow you to download two fonts, but many printers do
not. If your printer does not allow two downloaded fonts, the
Printer Menu will appear as shown in Figure 3. The
"Download As Font 2" and "Print Sample of Font 2" options
will be dimmed because they aren't allowed.

Download as Font 1
Print Sample of Font 1
Trowerrbansd oy Fond ¥

wr P gn e
RSN

Figure 3: Dimmed (Disabled) Menu Options

The very first time you run Power Print, we suggest you read
the Notes in the Apple Menu. Use up arrow and down
arrow (or A and Z) to highlight the Notes option, then press
return. After you've read the Notes, press esc to go back to
the Apple Menu.

Next, within the Apple Menu use up arrow and down
arrow (or A and Z) to highlight the Printer Setup option, as
shown in Figure 4.

About Power Print...
Printer Setup
Help

Hotes

Figure 4: Select Printer Setup

Then press return. The Printer Setup screen will appear as
shown in Figure Sa.
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HWhich Printer do you have?

APPLE DMP

APPLE IMAGEWRITER
EPSOH FX,JX,EX SERIES

OKIDATA 92,93

OKIDATA 192,193 (IBM COMPATIBLE)>
PAHASOHIC KX-P1092,1093
STAR GEMIHI,DELTA,RADIX

STAR 5G,SD.S5R

Use arrow keys and RETURH to select.
Press ESC to go back.

Figure 5a: Printer Setup - Printer List

Select your printer from the list (highlight the appropriate
choice, then press return). Select **** SEE MORE
CHOICES **** to view more of the list of printers.

If your printer is not listed and you're sure it has font
downloading capability, try selecting the Epson.

If you are using an Apple I/c, your Printer Setup is now
complete. You don't have to make any more choices because
Power Print automatically selects the proper interface and slot
number. Skip to "Saving and Testing the Printer Setup.’

After you select a printer, a list of printer interfaces will be
displayed (see Figure 5b). The interface is the connection
(cable, or cable plus circuit board) that enables the computer to
communicate with the printer. Select the interface you are
using. If you're not sure which interface to select, check the
owner's manuals for your computer and printer. If your
interface isn't listed, try the Apple Parallel or the Grappler.
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After you select your interface, a list of slot numbers will
appear (see Figure 5¢). Select the appropriate slot number. If
you're not sure which to select, you probably should use slot
1, which is appropriate for most printers.

"8 File Edit Printer

Which Interface do you have?

ALS PRINTERMATE
APPLE COMMUHICATIOHS
APPLE FIRMWARE
APPLE PARALLEL
APPLE SERIAL
APPL UPER SERIAL
APRICORH (Parallel?
APRICORH (Serial>
CCS 7710A
X%%% SEE MORE CHOICES XXkx

Use arrow keys and RETURH to select.
Press ESC to go back.

Figure 5b: Printer Setup - Interface List
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K1 File Edit Printer

il Printer Setup i

Interface in what slot?

SLOT
SLOT
SLOT
SLOT
SLOT
SLOT

Use arrow keys and RETURH to select.
Press ESC to go back.

Figure Sc: Printer Setup - Slot List

The esc key returns you to the previous list (from the Slot list
back to the Interface list, or from the Interface list back to the
Printer list). From the Printer list, esc returns you to the main
program.
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Saving and Testing
the Printer Setup

After you have made your selections of printer, interface, and
slot number, a screen appears that displays the choices you've
made (Figure 6).

il Printer Setup ||

You have chosen...

APPLE IMAGEWRITER
APPLE SUPER SERIAL
SLOT 1

Press RETURH to save this
set-up on POWER PRIHT disk.
Press ESC to 9o back.

Figure 6: Save Printer Setup

If the selections are correct, press return. This causes the
Printer Setup to be saved on the Power Print disk. Therefore,
Printer Setup is a one-time procedure that you do rot have to
repeat each time you load Power Print. If you switch to a
different printer or interface, then load Power Print, make the
appropriate selections, and save the new Printer Setup on disk.
If you regularly use more than one kind of printer, we suggest
you make a separate Power Print disk for each printer.
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Power Print allows you to run a test to make sure the printer
setup is correct and functional. After you save the printer setup
on disk, a screen appears (Figure 7) that reminds you to make
sure the printer is on-line {selected) and ready to be used.

| K3 File Edit Printer

il Printer Setup |l

Make sure printer is...

Powered On
Selected (Online)
Loaded with Paper

Press RETURH to test printer.
Press ESC to skip test.

A WELCOME MESSAGE will be printed
if correct selections were made.

Figure 7: Test Printer Setup

Press return to run the test. You can skip the test by pressing
esc, but we strongly suggest that you run it. If the printer and
interface selections are correct, the test prints a welcome
message (Figure 8).

e (AL LI T R R T

Figure 8: Successful Printer Test

For most printers, an "8-bit" test will follow the welcome
message. This test determines whether the interface can handle
the downloading requirements of the printer. (Some printers
don't require this test; for these printers, only the welcome
message in Figure 8 will be printed.)



The words "8-BIT TEST" will be printed followed by two
horizontal lines (Figure 9). If both lines appear, everything is
okay; if only one line appears, the interface can't download data
to the printer (see "Printer Problems?" below).

g-BIT TEST:

Figure 9: Successful 8-Bit Test

Printer Problems?

Here are some hints to help you figure out what's wrong if the
printer test fails.

The test prints garbage characters: You may have selected the
wrong printer or the wrong interface. Also, make sure you
have made any necessary DIP switch settings on the printer.
See the "Printer Information" booklet included with your
Power Print package for the proper DIP switch settings, if any,
for your printer.

The "8-bit" test prints only one line: The selected interface
can't send 8-bit data. It may require a jumper block or DIP
switch setting; refer to the instruction manual for the interface.
Also, make sure the printer is set up to receive 8-bit data (see
"Printer Information" booklet).

The program hangs (stops working) during the test: Make sure
the printer is turned on and selected (on-line). Also make sure
you've chosen the correct interface and slot number. If for
some reason you don't return to the program, either re-boot or
press control and reset to re-start Power Print.

14



How To Use Power Print
Ready-Made Fonts

We have provided a variety of ready-made fonts on your Power
Print disk. These fonts are designed to take advantage of the
capabilities of your dot-matrix printer. We have enclosed
sample printouts of the fonts in the "Printer Information”
booklet that is included with your Power Print package.

Your screen should now resemble the screen in Figure 1 (the
main program screen). Press esc to activate the menus, then

select the File Menu (use the right and left arrow keys to
move between menus).

Within the File Menu, select the Load Font... option, as
shown in Figure 10. Use the up and down arrow keys (or A
and Z on the Apple //+) to highlight the selection, then press
return.

File

Load Font...

Save Font

Save Font As...

List all Files

Change Current Disk
Delete a File

Create Quickload File
Quit

Figure 10: Select Load Font

The Load screen will then appear (Figure 11). This screen
lists the available fonts on the disk.



& §RICY Edit Printer

IR RO SRS GRERERAOE5

/POWERPRINT has 57 blks free
HAME TYPE BLOCKS

| ASCIL.2 | Font [8x91]
ASCII.PLUS.2 Font [8x9]
BYTE.2

s Font [8x9]
COUHT.2 Font [8x9]
DOUBLE.HIGH.2 Font [8x9]
FAT.2 Font [£8x91
OLD.EHGLISH.2 Font [8x91
OUTLIHE.2 Font [8x91

Use arrow keys to select a file.
Press RETURH to load it.
Press ESC to 90 back.

20000005 258 XREERO0000000
R

ddaddaiaaaaad

Figure 11: Load Font Screen

To select a font, use the up and down arrow keys (or A and
Z on the Apple //+) to highlight the desired selection, then press
return. Just to demonstrate, let's select the FAT.2 font (it may
be named FAT.1 on your font list).

Characters similar to Figure 12 will appear. To view all the
characters, use the up and down arrow keys (or A and Z on
the Apple //+).

Figure 12: Characters in FAT Font
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Now, press esc to return to the File Menu. Then use right
arrow to move to the Printer Menu (Figure 13).

Download as Font 1
Print Sample of Font 1
GBownload ay Font 2
Peint Sanpie of Fant 2

Figure 13: Downloading the Selected Font

Next, select Download as Font 1. Power Print will remind
you to make sure your printer is on and on-line. Press return
and the font you've selected will be downloaded to the printer.

Some printers allow you to download and use two fonts. If
your printer allows a second font, Download as Font 2 will
be enabled (not dimmed) in the Printer Menu. You may then
Sfollow the steps described above to select and download a
second font. You must use special printer commands to tell the
printer whether to use Font 1 or Font 2; these commands are
listed in the "Printer Information” booklet.

After you've downloaded a font, you may select Print
Sample of Font 1 in the Printer Menu. (First make sure
your printer is turned on and on-line.) A sample of the
characters in the font you've selected will be printed. Here's
how the sample printout of the FAT font looks on the Apple
Imagewriter:

17



POWER PRINT CUSTOM CHARACTERS - FAT.Z2
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Keep in mind that, depending on which printer you're using,
the way the font looks on the printout may be somewhat
different from how it looks above.

That's all there is to it! The font you've downloaded will be
used on printed documents. Just Quit Power Print from the
File Menu and load the program you want to use. Because the
font is stored in the printer rather than in the computer, the font
will be used on any printed report produced by any program
you run.

If you want to switch to a different font, simply re-load Power
Print and repeat the steps described earlier. Once a font is
downloaded, it will be used until you turn off the printer or
until you use Power Print to download a different font.
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Caution: Remember that the font is stored in the printer, not in
the computer, so don't turn off the printer until you're done
using the font. If you turn off the printer, the font is lost and
you have to repeat the downloading procedure. (Before you
turn the printer back on, remember to place the paper at the top-
of-form position.)

Now that you understand how to select and download a ready-
made font, let's look at how to use Power Print with
AppleWorks.
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Using Power Print With
AppleWorks

Power Print is easy to use with other programs, like
AppleWorks. Power Print adds beauty and style to your
AppleWorks documents. You can print your word processing,
database, and spread sheet documents in fancy fonts, and you
can use Power Print to create special effects such as borders
and even small graphics (as described in "Special Effects").

The Custom Printer

In order to use Power Print with AppleWorks, you must be
able to send control characters to the printer that tell the printer
when to use the standard font and when to use the downloaded
font. These control characters must somehow be included in
the AppleWorks Printer Options. (To see the Printer Options,
press OPEN APPLE-O in the word processor.)

Unfortunately, AppleWorks doesn't allow you to modify the
Printer Options for its built-in printers. Each option is pre-
defined and can't be changed. For example, the Boldface
Begin option contains the control characters that cause the
printer to start printing in boldface, and this function can't be
changed.
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The question is: how do you enter control characters for using
downloaded fonts in the Printer Options if AppleWorks won't
let you modify them for the built-in printers? The answer is: set
up a custom printer. AppleWorks does allow you to modify a
few of the Printer Options when you set up a custom printer.
The options you can modify are:

Boldface Begin (BB) and Boldface End (BE)
Superscript Begin (+B) and Superscript End (+E)
Subscript Begin (-B) and Subscript End (-E)
Underline Begin (UB) and Underline End (UE)
Lines Per Inch (LI 6 and LI 8)

Characters Per Inch (C1 4 - CI 24)

When you set up a custom printer, you can enter whatever
control characters you want in each of these options. For
example, you can enter the control characters that turn on the
downloaded font in the Boldface Begin option. When you use
the word processor and issue the Boldface Begin command, the
printer will turn on the downloaded font rather than boldface.
It's all the same to AppleWorks; it doesn't care whether
Boldface Begin means "turn on boldface” or "turn on the
downloaded font."

Unfortunately, if you use Boldface Begin to turn on the
downloaded font, you must use one of the other available
Printer Options to turn on boldface. AppleWorks provides
very little flexibiity in setting up printer functions, and Power
Print must work within these limitations. But don't worry:
we've worked out an optimal scheme for each printer. All you
have to do is enter the appropriate control characters in the
appropriate Printer Options as described below.

The "Printer Information" booklet contains a table that
summarizes the scheme for using the available AppleWorks
Printer Options. The table shows which Printer Option to use
to activate each printer function. (For example, use 8 Lines per
Inch to activate the downloaded font.) The table also shows the
keystrokes you type in the Word Processor to access each
Printer Option.
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How To Set Up a Custom Printer

To set up a custom printer, start with these menu selections:
Main menu: select 5 ("Other Activities")
Other Activities menu: select 7 ("Specify
information about your printer(s)")

Now you are in the Printer Information menu (Figure 14).

Disk: Drive 2 (Slot 6) PRINTER INFORMATION Escape= Other Activities

Printer Information |

Chan ge standard values
i Aeple DI (Slot 1)

Add or remove a printer
2. hdd a printer (maximum of 3)
3. Remove a printer

Wain Menu |
Uther Activities |

Change a Trlnter Tecxhcatlons
4. Reple DMP (Slot 1D
5. Imagelriter (Slot 1)

BPE a numper, Or use arrows, then press keturn

Figure 14: Printer Information Menu

There are two possible courses of action, depending on
whether or not you already have set up a custom printer:

e If you do not already have a custom
printer set up, make these selections:

Printer Information menu: select 2
("Add a printer")

Add a printer: select 12 ("Custom
printer")

23



e If you already have a custom printer set
up, AppleWorks will not allow you to
set up another one. Therefore, you must
either (a) remove the existing custom
printer and add a new one, or (b) change
the existing custom printer.

(a) To remove the existing custom printer
and add a new one, make these
selections:

Printer Information menu: select 3
("Remove a printer”)

Printer Information menu: select 2
("Add a printer").

Add a printer: select 12 ("Custom
printer")

(b) To change the existing custom printer:

Printer Information menu: select your
custom printer under "Change Printer
Specifications."”

Here's another tip: AppleWorks allows
only one custom printer on a disk, but
you can have two or more custom
printers if you store each on a separate
disk. Make a copy of your AppleWorks
start-up disk and then modify the
existing custom printer on the copy.

AppleWorks will ask you to enter a name for the custom printer
and to indicate how the printer is accessed. (If you're changing
an existing custom printer, these questions won't be asked.)
Enter the required information.

At this point your screen will resemble Figure 15.



Disk: Drive 2 (Slot 6) HOD W FRINTER Escape Frinter Information

Taln Menu |

ter Intormation |
Wl

Printer name: MY PRINTER (Slot 1)

Printer type: Custom printer

| ho

2. Rccepts top-of-page commands No

3. Stop at end of each page No

4. Platen width 8.9 inches
3. Interface cards

6. Printer codes

Ype 3 numper, or use 3rrows. then press keurn

Figure 15: Add A Printer

Most printers use these settings:

Needs line feed after carriage return No
Accepts top-of-page commands Yes

Stop at end of each page No

Platen width 8.0 inches
Interface cards

Printer codes

(Note: The Apple //c does not show the "Interface cards"
setting.)

Make the appropriate settings for your printer. Next, select

"Printer codes." AppleWorks will display the printer code
categories shown in Figure 16.
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Disk: Drive 2 (Slot 6) PRINTER CODES Escape: Change A Printer .

T Printer lodes |
I
2. Lines per inch
3. Boldface, Subscript and Superscript
4. Underlining

Main fenu I

Tfther Activities i
Frinter Information |

BPE 4 Number, Or use arrous, then press xeturn

Figure 16: Printer Codes

(Note: The "Serial card” category is displayed only on the
Apple lic.)

The Printer Options shown in Figure 16 are the ones

AppleWorks allows you to control when you set up a custom
printer.
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How To Enter Control
Characters

Now you're ready to enter the appropriate control characters in
the appropriate Printer Options. To do this, you need to know:

which control characters to use;
where to enter them;
how to enter them.

To demonstrate, we will show you how to enter the control
characters for the Apple Imagewriter printer. The procedure is
the same for all printers.

Which control characters to use: Look in the "Printer
Information" booklet that is included with your Power Print
package. Find the page for the printer you're using. In our
example we will use the information for the Imagewriter. At
the top of the page you will see a table that tells you which
control characters are used to perform each printer function.
The table for the Imagewriter looks like this:
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Printer Command Control Characters

Downloaded Font 1 ESCAPE'
Downloaded Font 2 (not available)
Standard font ESCAPE $
Normal leading ESCAPE A
Tight leading ESCAPE T16
Bi-directional printing ESCAPE <
Uni-directional printing ESCAPE >
Boldface Begin ESCAPE !
Boldface End ESCAPE "
Underline Begin ESCAPE X
Underline End ESCAPEY

In this table, ESCAPE means press the Escape key. Notice the
"Normal leading" and "Tight leading" printer commands.
"Leading” refers to the amount of vertical space between
horizontal lines of type. Normal leading is used by the printer
to print text; tight leading (less vertical space) is used to create
special effects such as borders and graphics (see the "Special
Effects" section). "Bi-directional printing" (the print head
prints while it moves in both directions) is used to print normal
text. "Uni-directional printing" (the print head prints in only
one direction) is used to create graphics (on some printers).

Where to enter the control characters: Now that you
know what the control characters are, you need to know which
control characters to enter in each of the available AppleWorks
Printer Options.

Look again at the page of information for the Imagewriter in the
"Printer Information" booklet. At the bottom of the page is a
second table. This table identifies each printer function, which
control characters activate each function, and in which Printer
Option the control characters should be entered. The table for
the Imagewriter looks like this:
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Apple Imagewriter, Imagewriter II, and DMP Printer

matrix size and type: 8x9 standard

16x9 overlapping (Alternate Matrix)

DIP switch settings: nonc required

printer functions:
Printer Command

Downloaded Font 1
Downloaded Font 2
Standard font
Normal leading
Tight leading

Bi-directional printing

Contro! Characters

ESCAPE '
(not available)
ESCAPE $
ESCAPE A
ESCAPE T16
ESCAPE <

Uni-directional printing ESCAPE >

Boldface Begin
Boldface End
Underline Begin
Underline End

ESCAPE !
ESCAPE "
ESCAPE X
ESCAPEY

suggested AppleWorks command substitutions:

To activate this enter these control in this AppleWorks
function. . . . characters. . . . Printer Option. . . .
Downloaded font® ESCAPE ' 8 Lines per Inch (LI 8)
(between paragraphs)

Standard font4 ESCAPE $ ESCAPE A ESCAPE < 6 Lines per Inch (LI 6)
(between paragraphs)

Downloaded font!:3 ESCAPE ' Boldface Begin (BB)
(within line)

Standard font* ESCAPE $ Boldface End (BE)
(within line)

Boldface Begin? ESCAPE ! Superscript Begin (+B)
Boldface End ESCAPE " Superscript End (+E)
Underline Begin! ESCAPE X Underline Begin (UB)
Underline End ESCAPE Y Underline End (UE)
Tight leading ESCAPE T16 ESCAPE > Subscript Begin (-B)

Lcancelled by next forced carriage return
2cancelled at end of printed line

3Add ESCAPE P to this command for the alternate matrix.
4Add ESCAPE N to this command for the alternate matrix.



How to enter the control characters: At this point your
screen should look like the screen in Figure 16, which is
repeated here.

lizk Drive 2 (Slot 6) PRINTER CQUES Escape: Change A Printer

T Frinter Information |
WIL
I
2. Lines per inch
3. Boldface, Subscript and Superscript
4. Underlining

ype 3 number, or use arrows, then press Return YK Avail.

Figure 16: Printer Codes

Select 2 ("Lines per inch"). The screen shown in Figure 17
will appear.
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Disk: Orive 2 (Slot 6) LINES PER INCH Escape: Printer Codes

e ————————————————————————————————————————————————————————————————————————————————

— Tein fenu |
T Uther Activities |
" Printer Information |
T Uines per inch |
1

2. 8 lines per inch

UPE 3 nunber, or use arrous, then press Refurn 5K Avail.

Figure 17: Lines Per Inch

Now select 1 ("6 lines per inch"). The screen shown in Figure
18 will appear.

Disk: Drive 2 (Slot 6) 6 LINES PER INCH

RN [T
T Ofher Activities |
T Printer Information |
T b lines per inch |

Current control characters are

None

QPE the exact control characters I’EQUIFE (~ = End): SR Avail.

Figure 18: 6 Lines Per Inch
(Before Entering Control Characters)



Now it's time to enter the appropriate control characters in the 6
lines per inch Printer Option. The table indicates that the 6 lines
per inch option is used to activate the standard font between
paragraphs (after a forced carriage return). The control
characters for this option are:

ESCAPE $ ESCAPE A ESCAPE <

To enter these control characters:

» Press the Escape key (do not type the
word "Escape").

« Type a dollar sign ($). Do pot include
any blank spaces in the control character
sequence. We have included blanks in
the table to make the control characters
more readable, but don't press the
spacebar when you enter the characters.
Type the dollar sign immediately after
you press the Escape key.

If at some point you make a mistake,
type a caret (). AppleWorks will return
you to the screen in Figure 17, and you
can start over.

« Press the Escape key again.
» Type a capital A.

 Press the Escape key again.
» Type a less-than sign (<).

At this point your screen will look like
Figure 19. The screen shows the control
character sequence. (Once again, even
though the screen seems to show blanks,
there are no blank spaces between
control characters; don't press the
spacebar.)
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Disk: Drive 2 (Slot 6) 6 LINES PER INCH

S TG T s
T Uther Activities |
T € lines per inch |

Current control characters are

Escape § Escape # Escape ¢

Figure 19: 6 Lines Per Inch
(After Entering Control Characters)

* To end the control character sequence,
type a caret (A). AppleWorks will return
you to the screen shown in Figure 17.

Now select 2 ("8 lines per inch"). The screen shown in Figure
20 will appear.

Note: Some printers use control characters (as opposed to
Escape sequences). To type a control character, such as
Control-A, hold down the control key while pressing the A
key.
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Disk: Drive 2 (Slot 6) 8 LINES PER INCH

A
T Other Activitles |
T Frinter Infornation |
T B Tines per inch |

Current control characters are

Hone

Figure 20: 8 Lines Per Inch
(Before Entering Control Characters)

The table shown earlier indicates that the 8 lines per inch option
is used to activate the downloaded font between paragraphs
(after a forced carriage return). The control characters for this
option are:
ESCAPE'
To enter these control characters:
* Press the Escape key.

» Type an apostrophe (). The screen will
now look like the screen shown in
Figure 21.
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Disk: Drive 2 (Slot 6) 8 LINES PER INCH

Crlainenu e
T Other Activities |
~ FPrinter Information |
T B lines per inch |
Current control characters are

Escape ‘

Figure 21: 8 Lines Per Inch
(After Entering Control Characters)

* To end the control character sequence,
type a caret (*). AppleWorks will return
you to the screen shown in Figure 17.

You have now entered the control characters for both the 6 lines
per inch and 8 lines per inch Printer Options. Press the Escape
key; AppleWorks will return you to the screen shown in Figure
16. Now select 3 ("Boldface, Subscript and Superscript").
The screen shown in Figure 22 will appear.
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Disk: Drive 2 (Slot 6) ENHANCENENTS Escape: Printer Codes

fain Menu |
T (Other Ackivities |

Printer Infornation |

|?ﬂ?§ﬁﬂ!§l gﬁmﬂl
oldface tnd
. Subscript Begln
. Subscript E

. Superscript Begln
. Superscript En

Enhancements

UPE numpber, or use arrous. them press xeturn

Figure 22: Enhancements

One-by-one, select each of these Printer Options and enter the
control characters indicated by the table in the "Printer
Information" booklet. Use the information that pertains to your
printer (remember that our example is based on the Apple
Imagewriter).

After you have entered the control characters for the Boldface,
Subscript, and Superscript options, press the Escape key and
AppleWorks will return you to the screen shown in Figure 16.
Next, select the Underlining option and enter the appropriate
control characters.

You may have noticed that we do not use the "Characters per
inch” option. This option is difficult to use because if you
substitute a different control character sequence for a
characters-per-inch setting, the margins of your document may
suffer. Even though characters per inch settings may be used
to store other commands, we feel it's just not worth the trouble.

After you have finished entering all the control character
sequences in their appropriate Printer Options, you can run a
test to make sure they are correct.



How To Test The Printer Options

We have provided a file on your Power Print disk that you can
use to test whether you have correctly entered the control
characters in the Printer Options. The test file is named
APPLEWORKS.TEST.

Before you run the test, use Power Print to download the
COUNT.1 (or COUNT.2) font (make sure your printer is
turned on and on-line). Then, from AppleWorks, load the
APPLEWORKS.TEST file and print it.

Figure 23a shows how the test file looks on your Word
Processor screen; Figure 23b shows the resulting printed
output.

File: POWERPRINT.TEST REVIEN/ADD/CHANGE eSsetuinn] Esc?pe= t|1ain Ilﬁenu
ihis 15 the STANDARD prinler font &

e 81 Br Inch: 8
This is the D HNLURDED font (exther COUNT.1 or COUNT.2) with
NORIAL SPACING a

ATIGHT SPACING
TIGHT SPACING
TIGHT SPACING=

Lines Ber Inch:

STANDARD FONT TESTA Thxs is the Standard Font and
thls is the ~Dounloaded Font ~and this 1s ~Boldface.®

Lines Eer Inch: 81
~DOWNLOADED FONT TESTA Thxs is the Downloaded Font
gnd this is the ~aStandard Font ~and this is ~Boldface ¥
--Lings ﬁer Inch: € lines
gere is a bullet: »)»  fnd here are some boxes: ~L[LLL~e

Type entry or use § comnands Line I Column 1 @7 for Help

Figure 23a: Word Processor Screen
For APPLEWORKS.TEST File
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Some Tips

Now that all the control characters have been entered and
tested, you're ready to use Power Print to download a font to
your printer and then use the downloaded font in an
AppleWorks document.

It's easy: when you're in the Word Processor, press OPEN
APPLE-O to access the Printer Options. Then select the
appropriate Printer Option to activate the desired effect.

Here are some tips about how to use the various Printer
Options.

printer function: downloaded font (at paragraph break)
AppleWorks Printer Option: 8 lines per inch (LI 8)

This Printer Option activates the current downloaded font. It
also activates normal leading (vertical space between printed
lines) and bi-directional printing. This option stays in effect for
the rest of the document unless it is cancelled by another Printer
Option command.

AppleWorks allows this option (and the 6 lines per inch option)
only between paragraphs (after forced carriage returns). If you
want to activate the downloaded font in the middle of a line, use
Boldface Begin.

printer function: standard font (at paragraph break)
AppleWorks Printer Option: 6 lines per inch (LI 6)

This Printer Option activates the printer's standard font. It
stays in effect until the end of the document unless it is
cancelled by another Printer Option command.

AppleWorks allows this option (and the 8 lines per inch option)
only between paragraphs (after forced carriage returns). If you
want to activate the standard font in the middle of a line, use
Boldface End.

39



6 lines per inch is the standard AppleWorks Word Processor
setting. Therefore, if you want to start a document with the
standard font, you do not have to issue the LI 6 command (just

start typing).

Apple-H screen dumps are printed in the font (standard or
downloaded) that was active at the end of the previous
document.

printer function: downloaded font (middle of line)
AppleWorks Printer Option: Boldface Begin (BB)

This option activates the current downloaded font until either a
Boldface End (BE) command or a forced carriage return,
whichever comes first.

You can issue the Boldface Begin command from the Word
Processor without pressing OPEN APPLE-O to enter the
Printer Options menu. Just type CONTROL-B to begin (turn
on the downloaded font) and then type another CONTROL-B
to end.

printer function: standard font (middle of line)
AppleWorks Printer Option: Boldface End (BE)

This option activates the printer's standard font. Boldface End
(BE) must be preceded somewhere in the same paragraph by a
Boldface Begin (BB). If necessary, issue two consecutive
commands: BB and BE.

printer function: Boldface Begin
AppleWorks Printer Option: Superscript Begin (+B)

This option creates a boldface version of the font that's
currently in use (either standard or downloaded).

AppleWorks automatically cancels this command at the end of
each printed line.
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printer function: Boldface End
AppleWorks Printer Option: Superscript End (+E)

This option cancels Superscript Begin (i.e., it cancels boldface
printing).

printer function: Underline Begin and Underline End
AppleWorks Printer Option: Underline Begin (UB) and
Underline End (UE)

No trick here: these options start and cancel underlining of the
font that's currently in use (either standard or downloaded).
You can issue these commands from the Word Processor
without pressing OPEN APPLE-O to enter the Printer Options
menu. Just type CONTROL-L to begin underlining, then type
CONTROL-L again to end underlining.

Some printers allow you to download two fonts at once; they
are identified as Font 1 and Font 2. In this case, Underline
Begin may be defined as the printer command for downloaded
Font 2 and Underline End may be defined as the command
used for switching back to standard font.

printer function: tight leading
AppleWorks Printer Option: Subscript Begin (-B)

Use this option when you want to print special effects such as
borders and graphics. It causes subsequent printed lines to be
jammed together vertically.

Subscript End has been disabled; in order to restore normal
leading, use the 6 lines per inch (LI 6) option. 6 lines per inch
activates the standard font; if you want to use the downloaded
font, follow 6 lines per inch with either an 8 lines per inch (LI

8) or Boldface Begin (BB) command.

41



Dot-Matrix Printing

The ready-made fonts supplied with Power Print open up a
new world of possibilities for your dot-matrix printer, but
that's only half the story. Power Print allows you to modify
fonts to suit your exact needs. In fact, you can create your own
custom fonts to produce special effects, such as mixing
graphics and text. But first. . . . (Isn't there always a "but
first"?)

Before you dive in and start customizing fonts, you need to
know how a dot-matrix printer works. If you're one of the
country's foremost experts on dot-matrix printing, go ahead
and skip this section; otherwise, let's explore the wonderful
world of the dot matrix.

A dot-matrix printer doesn't work the same way as a typewriter
or a daisy wheel printer. A typewriter has a separate type bar
(or section of a type ball) for each character. A dot-matrix
printer, on the other hand, uses a single print head to print all
the letters, numbers, and symbols. It performs this miracle by
creating each character as a pattern of dots within a matrix
(hence, "dot matrix").

A dot is a dot, but what is a matrix? A matrix is simply a grid
of columns and rows, like a sheet of graph paper. If dots are
cleverly arranged within a matrix, they form a character.
Figure 24 shows the dot patterns for several different
characters.
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Figure 24: Dot-Matrix Characters ("A", "a", and "*")

The matrix in Figure 24 is eight columns wide and nine rows
high. The print head on a dot-matrix printer corresponds to a
single column on the matrix. It contains nine dot-strikers called
"wires" arranged in a vertical column.

To print a character, the print head moves sequentially to each
column position in the matrix. At each position, the appropriate
wires are fired to create the vertical dot pattern in that column.

The wires press against the print ribbon to print the dots on the
paper, as shown in Figure 25.

—uddet

;

Figure 25: Side View of Print Head
(Printing Small "i")



Look at the capital A in Figure 24 . To print this character, the
print head prints seven consecutive dot patterns. In the first
(leftmost) column, wires 4 through 7 fire; in the second
column, wires 3 and 5 fire; in the third column, wires 2 and 5
fire, and so on.

Notice also in Figure 24 that the rightmost column of each
character is left blank; this is the blank space between printed
characters. If dots are drawn in the rightmost column, the
printed characters will run together horizontally (an effect you
sometimes might want to create intentionally; for instance, if
you're creating a script font or drawing a border).

Descenders

Notice in Figure 24 that the bottom row of each matrix is
shaded. (On some printers, the bottom two rows of the matrix
are shaded.) This is a Power Print convention that you will
become familiar with when you start to modify fonts. (Soon,
soon . . . be patient.) It means that the bottom row is not used
to form characters; no character can be more than eight rows
high. The bottom row is used by the printer to shift a character
down one additional row to form a descender.

A descender is the part of a character that prints below the line
of type, such as the tail on a lower case g, j, p, q, or y. Look
again at Figure 24; capital letters are generally formed within
the top seven rows of the matrix (rows 1-7), while lower case
letters are generally formed within rows 2 - 8.

When you use Power Print to modify a font or create your own
custom font, you can command Power Print to shift a character
down and make use of the bottom row (the bottom two rows
on some printers). (The command to do this is described in
"How To Customize Fonts.") This allows you to create
characters with descenders, as illustrated by Figures 26a and
26b. Figure 26a shows a lower case "g" that is not shifted
down into the bottom row of the matrix. Figure 26b shows the
same character shifted down to create the descender.
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Figure 26a: "g" Unshifted
Figure 26b: "g" Shifted Into Bottom Row

Matrix Size and Type

The size and type of dot matrix used to form characters depends
on the printer. The matrix shown in Figure 24 is the standard
matrix for the Apple Imagewriter. It has eight columns, and a
dot may be drawn in the center of each column. This is called a
standard matrix.

Now compare the standard Imagewriter matrix with the
intermediate matrix shown in Figure 27 . The intermediate
matrix (in this case, for the Epson FX-80/FX-100) has only 6
columns, yet there are 11 horizontal dot positions! How is this
accomplished? An intermediate matrix allows dots to be printed
on the lines between columns (the "intermediate"” positions) as
well as within the columns. Six columns plus five lines
between columns totals 11 dot positions.

An intermediate matrix does not allow dots to overlap.
Therefore, two immediately adjacent dots cannot be printed
within the same row; the dots must be separated by at least a
column width. The Apple Imagewriter has a trick up its sleeve:
it does allow dots to overlap. In addition to the standard
matrix, the Imagewriter offers an overlapping matrix, as shown
in Figure 27 . The overlapping matrix has 16 horizontal dot
positions.
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Figure 27: Matrix Types

Power Print automatically selects the matrix size and type that is
appropriate for your printer. Matrix size and type for various
printers is listed in the "Printer Information" booklet.

Now that you understand the art and science of dot-matrix
printing, you can use Power Print to customize fonts and create
special effects, as described in the following sections.
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How To Customize Fonts

Getting Started

At last . . . the preliminaries are over and we're ready to
customize fonts. To get started:

1 Load Power Print by booting the disk.
If you're already in the program, use the
esc key to return to the main program
screen (shown in Figure 1).

2 Select the File Menu and the Load
Font... option. A screen similar to the
one shown in Figure 11 will appear.

3 Select a font from the list of fonts. In
our example, we will use the ASCIL2
font (it may be named ASCIL1 on your
list). The right half of the screen shows
the characters in the font you've
selected. Use the arrow keys (plus A
and Z on the Apple //+) to scan through
the character set.

4 Position the blinking cursor over any
character in the font (for example, the
capital E, as shown in Figure 28), then
press return. A dot-matrix
representation of the character will
appear in the matrix area on the left of
the screen, as shown in Figure 28.
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Figure 28: Dot-Matrix "E" - Standard 8x9 Matrix

Figure 28 shows a standard 8x9 (eight horizontal dot positions,
nine vertical dot positions) matrix. As described in the
previous section ("Dot-Matrix Printing"), Power Print
automatically selects the matrix size and type suitable for the
printer you select in Printer Setup. Therefore, the matrix that
appears on your screen may differ from the one shown in
Figure 28. (For example, it may be an 11x9 intermediate
matrix.) The following procedures, however, are the same for
all matrices.

A reminder: The shaded row at the bottom of the matrix is an
extra row used by the printer to create descenders (see "Dot-
Matrix Printing"). (For some printers, the matrix has two
shaded rows.) No character can be more than eight dots high.
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How To Modify Characters

Since each character in a font is a dot-matrix pattern, it's easy to
change the shape of a character or draw a character from
scratch: just draw or erase dots. Follow steps 1-4 described
earlier to load a font and select a character from the font, then
poise your fingers over the keyboard and try out these

procedures:
arrow keys (plus

A and Z on the
Apple II+)

spacebar

Move the cursor to the matrix location
where you want to draw or erase a
dot. (Notice the position indicator
"X= Y=" at the bottom right of the
screen. X is the horizontal direction,
Y the vertical.)

Switches (toggles) the cursor between
a "pen" (solid- dot cursor) and an
"eraser" (hollow-dot cursor). The
pen draws dots, and the eraser deletes
them.

Press once for "pen." The cursor
becomes a solid dot, and a dot is
drawn at the current matrix location.
If you then press any arrow key (or
A or Z on the //+), a dot is drawn at
the next location the cursor moves to.
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Press again for "eraser." The cursor
becomes a hollow dot, and the dot at
the current matrix location is erased.
If you then press any arrow key (or
A or Z on the //+), the dot at the next
location is erased.

Pen "up"; no drawing or erasing.
The cursor becomes a crosshair.
After you press period, you can
move the cursor without drawing or
erasing dots.

To resume drawing or erasing, press
the spacebar.

Insert blank column between dots
Delete column

Insert blank row

Delete row

"Shift" the character down to create a
descender (for example, a lower case
g J, P> q, or y). Press s again to use
the top row of the matrix to create
non-descender characters such as b,
d, f,h,ik,1 and t.

Erase all the changes made so far.The
character returns to its original form.

Also use esc to access the menus at
the top of the screen.

Use when finished with changes to
this character. The cursor moves to
the character font at the right side of
the screen.
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Edit Menu

Clear Character
Set

Edit Menu
Alternate Matrix

Edit Menu
Copy

Also use return to select another
character from the font.

Erase the entire character. The
character is deleted from the font.

Erases all the characters in the current
font. Power Print asks you if you
really want to clear the character set.
Use the arrow keys to select Yes or
No, then press return.

Some printers allow you to work with
more than one matrix. (For example,
the Apple Imagewriter offers both a
standard 8x9 matrix and an
overlapping 16x9 matrix.)

When you select Alternate Matrix,
the matrix on your screen
automatically changes to the alternate
format.

If your printer does not offer an
alternate, Alternate Matrix will be
disabled (dimmed) in the Edit Menu
and you will not be able to use this
option. The "Printer Information"
booklet included with your Power
Print package indicates whether your
printer offers an alternate matrix.

Same as typing c¢. Creates a copy of
the current character. You can Paste
the copy elsewhere in the same font
or in a different font.
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Edit Menu
Paste

Edit Menu
Erase

File Menu
Save Font
Save Font As

Same as typing p. Moves a character
that has been Copied (and currently
appears in the matrix) to the currently
selected character location in the
current font.

Same as typing e (see above). Erases
the current character; the character is
deleted from the font.

Saves the current version of the font
on disk.

Save Font causes the new version
of the font to replace the original
version on the disk; the original
version is lost.

Save Font As... stores the new
version of the font as a new, separate
font; the original version is
unchanged. Power Print asks you to
enter a name for the new font. The
name must start with a letter (A-Z).
After the first letter, it can include
numbers (0-9) and periods (.). It can
be no more than 15 characters long
(including periods, if any).

Disk space on the Power Print disk is
very limited. If you select Save Font
As, you should store the new font on
a separate disk (or delete existing
Jfonts that you don't use). Before you
store the font on a separate disk, use
the ProDOS System Ultilities or the
Beagle Bros File Mover program to
format a blank disk.
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That's all there is to it. With a little practice, you'll become an
expert Power Print calligrapher. Figure 29 illustrates a very
simple character modification. Figure 29a shows a regular
capital E; Figure 29b shows how additional dots can be added
to create a bold version of the character.
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Figure 29a: Character Before Modification
Figure 29b: Modified Character
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Non-Editing Options
In addition to the character-editing functions described above,

Power Print provides you with several other functions that
make life easier. They are:

File Menu
List All Files

File Menu
Change Current
Disk

File Menu
Delete a File

Lists the name of the current disk, the
number of blocks of free space left on
the disk, and the name and size (in
blocks) of every file on the disk.

Allows you to change to a different
disk (for example, if you want to use
a font stored on another disk). Power
Print will ask you to specify the
location of the new disk; enter either
drive and slot number (usually drive
6, slot 1) or pathname.

Allows you to remove a file you no
longer need from the current disk.
Caution: The file is deleted
permanently. Power Print will ask



File Menu
Quit

File Menu
Create Quickload

you if you really want to delete the
file. Use the arrow keys to select
either Yes or No, then press return.

Allows you to exit from Power Print.
Power Print will ask you if you really
want to Quit. Use the arrow keys to
select either Yes or No, then press
return.

Use this option to create a Quickload
File. Quickload is a feature of Power
Print that enables you to download
fonts without running Power Print.
For example, you could create a
Quickload File that would both
download a font and start your
AppleWorks program; the font would
then be used when you printed a
document from AppleWorks.

See "Saving Time With Quickload
Files" for a description of how to
create and use Quickload Files.

Now you have been introduced to the basics of Power Print.
With a little experimentation, you will discover increasingly
sophisticated and powerful uses. The next section gives you a

few hints about how to produce some very special effects with

Power Print.
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Special Effects

To spark your imagination and give you a feel for the many
ways Power Print can add style and creativity to your dot-
matrix printing, this section gives some hints about how to
create two special effects: borders and graphics.

Borders

Power Print makes it easy to add decorative horizontal borders
to your dot-matrix printouts. Some of the fonts on the Power
Print disk include special characters that may be used for
borders. These characters are substituted for seldom-used
keyboard characters, such as { and A . Figure 30 shows a
sample border character from the FAT font.

Figure 30: Border Character From FAT Font

This character appears in place of the } character (note the
"KEY: }" identifier at the bottom of the screen). Notice that the
rightmost column, which is normally reserved for the space
between characters, contains a dot pattern; that's how you can
identify a border character. When this character is printed
repeatedly, there is no space between each pair of characters;
the end result is a border.
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To draw a border, simply:

1 Load Power Print. Select a font and
choose a border character (or create your
own border character; be sure to use the
rightmost column). Note which
keyboard character corresponds to the
border character (as indicated by "KEY:"
at the bottom of the screen).

2 Download the font and Quit Power
Print.

3 Run your program (e.g., AppleWorks).
To create the border, repeatedly type the
keyboard character that corresponds to
the border character. Only the keyboard
character will appear on the screen, but
when the document is printed, the border
character will be printed in place of the
keyboard character.

For example, to create a border using the character shown in
Figure 30, load Power Print, select the FAT font, and
download the font (make sure your printer is on and on-line
before you download). Then load the program you want to use
(for example, AppleWorks). Repeatedly type the } character
where you want the border to appear. Figure 31a shows an
AppleWorks Word Processor screen; Figure 31b shows the
resulting printed output.
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Figure 31a: Creating a Border - Word Processor Screen
Figure 31b: Printed Border

Printing Graphics With Power Print

Power Print offers you an added dimension of power: you can
create small drawings (for example, a company logo). To
illustrate the technique, let's look at a sample graphic we've
provided on your Power Print disk. Load Power Print and
select either the PANDA.1 or PANDA.2 font. PANDA.1 (see
Figure 32a) is designed in an 11x9 matrix format for printers
-such as the Epson. PANDA.2 (see Figure 32b) is designed in
an 8x9 matrix format for printers such as the Apple
Imagewriter.
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Figure 32a: Panda - 11x9 format (e.g., Epson)
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Figure 32b: Panda - 8x9 format (e.g., Imagewriter)

Notice that each "character” in this font is a piece of a drawing
of a panda. (If you scan through the font, you'll notice that it
also includes an all-caps alphabet.)

To create a drawing, start by laying it out on graph paper. We
have provided you with some graph paper samples in the
"Printer Information" booklet that you can copy and use to lay
out your drawings.

The major divisions on the graph paper correspond to the
characters in a font. Each division is subdivided into a matrix.
The size of the matrix depends on the printer you're using;
select the graph paper with the correct matrix size for your
printer. For example, use the 8x8 grid paper for the
Imagewriter. (Why 8x8 instead of 8x9, which is the printer
matrix size for the Imagewriter? Recall that the bottom (9th)
row of the matrix is used by the printer to create descenders
(see "Dot-Matrix Prmting" earlier). No character can be more
than eight dots high.)



Draw dots within the matrix to form each "character" of the
drawing. When you're laying out a drawing, we suggest you
ignore intermediate and overlapping dot patterns. Just draw
dots in the centers of columns; it's easier, and the end result is
just as good.

To give you an idea of how to lay out a drawing, Figure 33
shows the Panda layout in two formats. Figure 33a shows the
layout for the Epson (each matrix is 6x8); Figure 33b shows
the layout for the Imagewriter (each matrix is 8x8).

Figure 33a: Panda Layout - 6x8 Grid (Epson)

61



Figure 33b: Panda Layout - 8x8 Grid (Imagewriter)

The next step is to transform the drawing into a Power Print
font. Load Power Print and either select a blank font or use
Clear Character Set in the Edit Menu to delete all the
characters from an existing font.

Now, one character at a time, draw the dot pattern to create the
character. Figure 34 shows the dot pattern used to create the
Imagewriter Panda's right eye. (Note that the right eye
corresponds to the keyboard character "5".)
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Figure 34: Panda’s Right Eye (Imagewriter Version)

When you're finished, save the font on disk. (Use Save Font
As... to save it as a separate font.) After you've created and
saved the font, here's how to print the drawing it contains:

1 Load Power Print. Select and download
the font that contains the drawing.

2 Quit Power Print and load your program
(for example, AppleWorks).

3 Change the vertical line spacing on your
printer to "tight spacing” (see the
"Printer Information” booklet). In
AppleWorks, use the "Subscript Begin"
(-B) Printer Option. If you don't do
this, the pieces of the drawing won't fit
together vertically.



4 Type the characters that make up the
drawing in their proper sequence.
Figure 35a shows the character sequence
for the Epson Panda; Figure 35b shows
the character sequence for the
Imagewriter Panda.

Subscript Begin (tight spacing for graphics).

8 Lines per Inch (select downloaded font)

b
ABCOEFGH
[ JKLIHOP
i

panda Inck
]

Lires per Inch 6 lines
Dear Joe, %

¥ <
How do you like my new loat
4

Type entry or use ¢ commands \ Line I Column 1 ¢-7 for Help

6 Lines per Inch (back to normal spacing and standard font).

Figure 35a: Character Sequence For Panda
(Epson Version)



REUI?@/QD CHA _E s st Esc?pe: Tain ?enu

Al
e ¢
)**:' /3
12343
ABCOEF GH
[ JKLMNOP
ARSTUVMRx
¥

panda inck
%

-------=_ines per Inch: € lines
Dear Joe,#

%
Hou do you like ny new logo%#

Type entry or use ¢ commands Line { Column 1 G- for Help

Figure 35b: Character Sequence For Panda
(Imagewriter Version)

5 Print. (Remember to change the line
spacing back to normal spacing after
you've finished printing the drawing.
Use 6 Lines per Inch in AppleWorks.)
Figure 36a shows the printed Epson
Panda; Figure 36b shows the printed
Imagewriter Panda.

PFARDR XIHC

Dear Joe,

How do you like my new logo?

Figure 36a: Printed Panda (Epson Version)



How do owon Tike my new Togo?

Figure 36b: Printed Panda (Imagewriter Version)

One more trick: As far as your printer is concerned, the
characters in a drawing stored in a Power Print font are the
same as text. Therefore, the special text commands that your
printer offers (condensed and expanded printing, bolding, and
so on) may be used to change the appearance of the drawing.
Try it and see. Of course, these special printer commands
work with regular text fonts as well.
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This section is intended for users with some experience in
Applesoft BASIC programming. Quickload files perform the
same function as "Downloading a Font" from within the Power
Print program.

Saving Time With
Quickload Files

Power Print gives you the option to create special files called
Quickload Files. Quickload Files allow you to download fonts
to your printer without booting the Power Print disk. In fact,
you can download a font by giving a single command from
ProDOS or from within a BASIC program. You can create an
"auto-boot" program that will download a font and then start a
program such as AppleWorks; the downloaded font will be
used on printed documents generated by the program.
Interested? Here's how to do it:

1 First, select the font you want to use.
Load Power Print; in the File Menu, use
the Load Font option to make a
selection from the list of available fonts.

2 Next, identify the disk on which you
want to store the Quickload File. You
will probably want to store it on a disk
other than the Power Print disk (for
example, your AppleWorks disk). In
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the File Menu, use the Change
Current Disk option to specify where
the Quickload File is to be stored.

3 Now create the Quickload File. In the
File Menu, select the Create
Quickload File option. Power Print
will ask you to enter the name you want
to assign to the Quickload File. The
name must start with a letter (A-Z).
After the first letter, the name may
include letters, numbers (0-9), and
periods (.); no other characters are
allowed. The name may be no longer
than 15 characters (including periods, if
any). It's a good idea to assign a name
that will remind you of which font is
downloaded by the Quickload File (for
example, LOAD.OUTLINE for a
Quickload File that downloads the
OUTLINE font).

If your printer allows you to download
more than one font at the same time (for
example, the Epson FX-80/FX-100),
Power Print will ask you whether this
font (selected in step 1) is to be
downloaded as Font 1 or Font 2.

Power Print will create the Quickload
File and store it on the disk specified in
step 2.

The Quickload File created in steps 1-3 is now ready to be
used. You can use the Quickload File to download a font from
ProDOS or BASIC without booting the Power Print disk and
without running Power Print. Here's how:
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4 Make sure the disk that contains the
Quickload File (see step 2) is inserted in
the proper drive.

5 Make sure your printer is turned on and
on-line.

6 From ProDOS, enter:
-filename <return>

where filename is the name of the
Quickload File (see step 3).

From within a BASIC program, use this
statement:

nnn PRINT CHR$(4) "-filename"

where nnn is the program line number
and filename is the name of the
Quickload File.

The font will be downloaded to the
printer. It then will be used on printed
documents until the printer is turned off
or until a different font is downloaded.

The sample "auto-boot" BASIC program below could be used
to download a font and start AppleWorks. The font would then
be used on printed AppleWorks documents. This program
uses a Quickload File named LOAD.OUTLINE. Assuming
that the Quickload File is stored on the same disk as
AppleWorks, here's the program:

10 PRINT CHR$(4) "-LOAD.OUTLINE"
20 PRINT CHR$(4) "-APLWORKS.SYSTEM"

To save this program on disk, just type:

SAVE LOADER
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Disclaimer of All Warranties and Liabilities

Even though the software described in this manual has been tested and reviewed, neither Beagle Bros nor its
software suppliers make any warranty or representation, either express or implied, with respect to this manual, the
software and/or the diskette; their quality, performance, merchantability, or fitness for any particular purpose. Asa
result, the diskette, software and manual are sold “as is,” and you, the purchaser, are assuming the entire risk as to
their quality and performance. In no event will Beagle Bros or its software suppliers be liable for direct, indirect,
incidental, or consequential damages resulting from any defect in the diskette, software, or manual, even if they have
been advised of the possibility of such damages. In particular, they shall have no liability for any programs or data
stored in or used with Beagle Bros products, including the costs of recovering or reproducing these programs or data.
Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential
damages, so the above limitation or exclusion may not apply to you.

ProDOS™

This product includes software, ProDOS™, licensed from Apple Computer, Inc. Apple Computer, Inc. makes no
ies, either express or implied, regarding the enclosed computer software package, its merchantability or its

fitness for any particular purpose. Some states do not allow the exclusion or limitation of implied warranties or

liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you.
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